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Chapter 1. Starting Up

1.1 Starting Candy

Start the System from the windows desktop by double clicking on the Candy shortcut. ~ “andy

Complete the user Login with your User Name, Initials and Company name.

Login details..

Mame: bl ark, & drian biller Imitiake:  hdah

Compary:  ABC Congtruction Company

e A

1.2 Company Manag er

This is the top level menu in the systemwhere a maximum of 24 companies may be created.

Company Manager
{3 Company View Tools RQxAES @
Code Company Name: No
) New Header o~
158686 [S] ABC Construction A
CACCSWINVLOCAL Select

For example, if you aretendering in a joint venture with another firm, you can create a brand new
company for that bid.

To select a conpany, position the cursor on the required company and use Enter or Double click .
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1.3 Create a New Company

Do this
Click the Company > New > Company menu.

Company Manager
{3 Company View Tools RO XAMS @
Co | New |Company | Mo
| Data Folder Manager Heading p
1586 Rename A
x Delete Ctrl+Drel I
¥ Properties
Login
CACCSWINNLOCAL

Editt he company name to read (‘)raining Companybéd

( Mew Company A @IAF

Dietails Logo Motes

Compary Mame CCS Training Compary

Compaty Code 105463

FPazzward [ Set paszword ]

OK || Cancel

Note: You may enter a Company Code and a Password for your company
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Company & Job Manager

The company O0CCS Training Companyo
Company Manager
{3 Company View Tools BAXAMS @
Code Compary Name No
() New Header -
121079 [E] crs Training Company B
152626 [E] ABC Construction A F
CACCSWINNLOCAL
1.4 Job Manager
Doubleclick on t he 0 CCS nmipraaniymbi ngo access
lob Manager: Jobs in company 'CCS Training Company’
{3 lob Edit View Tools HAxAHnEI @
Job Name Code s
=) New Header .
(Z NewJob 124305  BO1
4 | (11 k
CACCSWINGOY 8 |

has

he

now been

Jobs in t

The job manager generates a new header and new job automatically. You may createup to 99
jobs within a company that may be copied, renamed, deleted and backed up using the Job menu

or using the Right-click Menu.

c

h €
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1.5 Create a new Job

Do This
Click the Job > New Job menu.

Job Manager: Jobs in company 'CCS Training Company’
i3 Job Edit View Tools RO AELS @
2

| New job ] Cod
= New heading

Duplicate job 184305  BO1
Rename

Delete Ctrl+Del 3
Properties

Backup/recover job 3

Company Manager Esc
<1 Recent Jobs [y S k

CACSWINGOVE

Editthejobn a me t oWarsetaed Wat er

New Job Properties (2] =8 ]
Details Logo Motes
Jab Mame W azte Wwhater Treatment works

Job Code 147005

Job Paszword [ Set passwaord ]

[ ok || cancel

Note: You may designate a Job Code and Password for your job

Company & Job Manager

Treat melh:ltsé and t hen

lob Manager: Jobs in company 'CCS Training Company’

{® lob Edit View Tools RAaxaEgS @
Job Mame Code NIJ 4
(=) New Header A
1Z] Mew Job 131761  CO5|_|
=] Waste Water Treatment Works 147005 CO6| "

4 1M F
CACCSWINVCOY_C [ New [][ Select |

Open the job by double clicking on the job or by clicking
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1.6 Recover the CCS Demo Job

From the Job Manager click Job > Backup/recover job > Recover into a NEW job > from file

@/ lob | Edit View Tools RAXHAEI @
Mew job | Cod | o |
= MNew heading A
Duplicate job i
Rename :Bdﬂ?? BO6 'l
Delete Ctrl+Del BG4 R
Properties
! | Backup/recover job Backup the selected Job.. *
CM = | Recover into a NEW Job.. :lom cor'l:_mon
- rom archive
Backup utilities L4
Recent Jobs L4 i
e Edit remote backups L4 from email
| from file |

from restored folder
from floppy disk

Recover the Ventshaft and Substation Contract using the following directory on the Candy
Installation CD <CD Drive>/FSCOMMAND/Demo Jobs /Ventshaft and Subs tation Contract

. <« DVD RW Drive (E;) CANDY VERSION » FSCOMMAND » Demo Jobs - ||

By Organize ~ Vs ] older

Name Date modified Type

Master Library Job
Ventshaft and Substation Contract

Favorite Links

i Web Site setup
Ml Desktop

95 Recent Places
1% Computer

E Documents
ﬁ Pictures

H’ Music

[ Recently Changed

More »

Folders ~

File name: Vertshaft and Substation Contract
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V2F Backup Recoevery Warning

O You are about to recover COMPLETE JOB data from job:
161493 - Vent shaft and Substation Contract

Continue?

Click to confirm

lob Manager: Jobs in company 'CCS Training Company - €203
{3 lob Edit View Tools BRAXAES @

Job Name Code !

[=3 Mew Header o

|Z] Ventshaft & Substation Contract 152879 |_

m

Ll {111 | I

C:\Users'\Evelio\Documents\CCSDATA\CCSDATA New |4 | [ Select |

Click on to access theVentshaft & Substation Contract



Chapter 2. Candy User Interface

Candy Button System Toolbar Title Bar Application Tab Candy Version
B
o 2
Estimating H Planning H Forecasting ” Cashflow ” Yaluations ” Earned Yalue ” Materials ” Drawings

Main  Bill Prep  Documents  Adjudicators gIndirects  Check ®Review  Finalisation Reports  Advanced  Housekeeping

@TTadjT@ZE} < ho Master »

7@1 @-EgmofnE

}Ms Suppoark

General Toolbar

Application Menu

Application Toolbar

General Menu

Customise Toolbar

The Candy user interface consists of four main sections namely: Title bar, Application Tahs
Application Menus & Toolbars.

2.1 Candy Navigation

Candy button
System toolbar
Title Bar
Candy version

Application tabs
Application menu

General menu

General toolbar

Applicati on toolbar

Customise Toolbar

To select the job manager, system settings and to exit the

software

Job manager and system settings toolbar buttons

Displays the company and job you are working in

Displays the software version installed on the computer and

displays the system information

To select the Various Candy applications

Displays the menus of the application selected

Menu for Utilities & Help including telephone list, daily dairies,

card games, help files, licence registration, support information
& a website link to Update the Candy version

Displays general tool buttons for use on all applications

Displays shortcuts specific to the application selected. This tool

bar changes when a different application tab is selected

To select the toolbar buttons displayed on the different

toolbars



2.2 Document Navigation

Do this
To add the Standard Bill of Quantities Document to the Document Manager click on

Documents>Estimating Documents  then click [Mew | and Select1.1 Standard Bill of Quantitie s
and confirm ‘i/ then click | Select to open the document .

Document Title Document Menu Document Toolbar Split Screen Buttons

1.1 Standard Bill of¥uaryfties = EEE ol
. . = olumn
) Edit View To B XHEIS @
Escape X Selector
. Mett
YL item Bill Description Unit  Bill Qty Rate Amount €
=1 SECTION 2: VENTILATION SHAFT 4,858, 858.65 -
=2 SCHEDULE NO.1: FAN FOUNDATION 4,859,328.57
Select all =3 EARTHWORKS 1.843,825.25
records A Clear and strip site Mo L 5,400 3.99) 21,546,060
B Excavate in bulk, Class 4 material m3 10,8600 40,24 434,592,600
and dispose within 2km freshaul
distance
C Excavation in foundations ne 2m deep |m3 1,125 34.74 39, 032,56
Record
Selector D Excavate for working space in Class A|m3 tatt] 27.18 17,5938.80
material and backfill and compact to
958 mod. AASHTO. =
Bilpags 1 _#w4[1ci7 b M Gotopage ] [ Wagshest [3] [ Caloulate [+

Page Navigation

Buttons Function Buttons

Document Title The name of the document

Split screen Resizes the document to the top or bottom half of the screen.
buttons
Escape Go back to the previous menu.

Document menu The menus available for this document

Tool buttons for larger or smaller screen fonts, line deletion, find
& replace, export to Excel and print screen.

Document toolbar

Select all records Selects all records in the Bill of Quantities.

These buttons relate to the function keys on the keyboard.
Namely; Calculate (F12), Worksheet (F11) and Go to Page (F10).
NB: If the rates and heading totals require re-calculation, click
the red calculate button.

Function Buttons

Record selector
Column Selector

Page Navigation
Buttons

Selects the entire record. Right click to display the record menu
Sekcts the entire column. Right click to display the column menu

Scrolls between different pages namely; first page, previous
page, next page and last page of the bill.
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2.3 Right click menu functions

User Interface

The menu functions in Candy are context sensitive; therefore, specific tasks can be performed
directly on the documents cell, record, or column by right clicking for additional options.

In acell: Pagel: 1.1 Standard Bill of Quantities
{3 Edit View Tools

TIL ltem Bill Description Unit
_ = SECTION 2: WENTILATION SHAFT
:E' 2 SCHEDULE MQL1: FAMN FOLINDATION
= 3 EARTHWORKS
Right Click |
T mm_mz
T ._D Copy Ctrl+C
] B |} Paste Ctrl+V m3
— Format descriptions..
] o Add comments to bill item above .
T LConsclidate comments upwards
T O Copy from Pricing code description M3
Internal item L
_ Lock ALL bill descriptions & units
Page 1: 1.1 Standard Bill of Quantities
In a record selector : O Edit View Tools
TIL ltem Bill Descrigtion Unit
_ = SECTION 2 WENTILATION SHAFT
:E' 2 SCHEDULE MO FARN FOLNDATION
_H 3 EARTHWORKS

Right Click —»i

Copy Ctrl+C
Paste Ctrl+¥

=1
== |
X

Delete Ctrl+Del
Inzert Ctrl+Ins

xBill item properties..
Headings & Comments
Paginating the Bill

Item and reference no. utilities
Description & unit utilities
Quantity utilities

Pricing and rate utilities
Markup

Attributes

XREF

Code allocation
Subcontract adjudication
Print

v vy v vy v ¥ v vy v v v w

s A matenal and
ehaul distance

ns ne 2m deep
pace in Class A

d compact to 95%

aterial for trenches
mpact, and dispose of

nsin Class &
aterial

around foundations in
pacted to 5% mod

3

3

3

3

3

3
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In a selected column :

Right Click

User Interface

i3 Edit View Tools

-
-

@ Eill Description

i
LT

Uit

Sort
Filter..

Group by..
Find Ctrl+F

Format descriptions..

Add comments to bill item abowve
LConsclidate comments upwards
Copy from Pricing code description
Internal itern

Lock ALL bill descriptions & units

Column layout.. Ctrl+F1

Column Help

10

(i

m3

mad

mad
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2.4 Keystrokes, Icons and Mouse Functions

Mouse Functions
Note: This table assumes that the mouse buttons are configured for a right-handed user.

Left-click On an Active Document - moves the cursor line to and positions the editing
cursor at the mouse pointer. On an Inactive Document - Turns the document
Active and acts as above.

Right-click On an Active Document calls up the context menu.

Double Click Fetch another document, i.e.: Double Click on aNet Rate calls up the
Worksheet.

Row Record Select a line of data for Dragging and Dropping.

+Left-click

Row Record Marks the Start and End of a Range of records for Dragging and Dropping.

Shift+Left-click

Alt+Left-click Set an Alternate document.

Keystrokes

This is a listof the Editing and Cursor Movement Keystrokes, with a brief explanation of the
function, and the equivalent Icon if available.

Note: Normal Windows shortcut keys can be used e.g. Ctrl Cd Copy, Ctrl V& Paste etc.

B Shift+tEsc(ape)  Returns to the job selector
€ Esc(ape) Returns to the previous menu
=] Ctrl+Tab Moves the document currently on top to behind all other documents.
Ctrl+Insert Inserts anew line at the cursor position
bl Ctrl+Del Deletes the current line at the cursor
Tab Moves the cursor forward to the next Field. Shift+Tabmoves the cursor
backwards.
Home Moves the cursor to beginning of the field
End Moves the cursor to the end of the field
Ctrl + > Move to the next page
Ctrl + < Move to the previous page

11



Ctrl+Page Up
Ctrl+Page Down
Ctrl+Enter
Backspace
Ctrl+Backspace
Ctrl+Left-arrow
Ctrl+Right-arrow
Ctrl+Up-arrow
Ctrl+Down-arrow

Shift+Ctrl+Down -
arrow

Shift+Ctrl+ Up-
arrow

Ctrl+Space Bar

Shift+Ctrl+Space
Bar

Ctrl+R

Shift+Ctrl+R
(Ctrl+D)

Ctrl+U

Ctrl+L

Ctrl+T

Ctrl+K

Ctrl+J
Alt+Del
Shift+Alt+Del
Ctrl+z

Takes you to the first line of the first page of a document
Takes you to the first line of the last page of a document
Split the line at the cursor position

Deletes one character at a time

Deletes one word at a time

Bubble Up - move the current line up

Bubble Down - move the current line down

Collapse level headings (to hide all text under headings)
Expand level headings (to $1ow all text under headings)

Opens all sub headings within the cursor position heading

Closesall sub headings within the cursor position heading

Open all headings completely

Closeall headings completely

Pick Up the current Line

Drop (insert) Lines picked up using Ctrl+R at the current line

Turn current line to UPPERCASE letters

Turn current line to lowercase letters

Turn current word to Sentencecase

Copy the Field above

Copy the Field above and moves cursor down one line
Close the active Document.

Close All Documents.

Undo.

Note: As soon as the cursor is moved off the line, the line is stored

and the undo button will not function

12




Chapter 3. Post Tender Checks

Explanation

The estimate created by the tender department in Candy Estimating can now be used by the
Site Team. It is essentiato do some post tender check to prepare the Tender for Post Tender
use.

Recover the estimate and do the following Checks. It is good practice to copy the job before
Remodelling the job for Post Tender Valuations. Eventually theQ.S will have and electronic copy
for the Job at Estimate Stage and a copy for the Remodelled Job for use at Post Tender Valuations
stage.

Do This

Go to the Job Manager % Duplicate the Ventshaft & Substation Contract , rename the job to
Ventshaft & Substa tion Contract - Remodelled .

Job Manager: Jobs in company 'CCS Training Company - C203"
i3 Job Edit View Tools RAxHaES @

Job Name Code

) New Header
Lij Ventshaft & Substation Contract 152879
|_§j Ventshaft & Substation Contract - Remodelled 166919

»

m

Fl T I

C:\Users\Evelio\Documents\CCSDATAVCCSDAT, New |+ | [Select

13



3.1 Job Information

Certain useful information like the Contract Value and Job Size can be analysed

Trade Totals Display

Do this:
Choose the Valuations application tab.

B 5 1 CCS Training Company - C203 - Ventshaft & Substation Contract - Remodelled
G

Vg N
Estimating H Planning H Faorecasting ” Cashflow (” Valuations ”)Materials ” Drawings

Main Documents Adjudicators  Indirects  Check & Review  Finalisation Reports  Subcontract  Areas  Advanced Housekeeping

QTTadi%TQEE}‘PIWOMEﬂﬁ?’ innuvaluatium

The job total by trade can be displayed by clicking the Tr (Trade Totals) icon.

Initial Valuation setup

The Initial Valuation setup dialog appears when accessing the Valuations Application for the first
time. The valuation setup dialog is usedfor entering details for the first Valuation.

Enter the Valuation Date, Number and header.

Initial Valuation set up @

Valuation details -
Current quartity date 25/06/2010 LJ

Valuation number 1
Valuation header
Valuation 1

Indirect costs
Exclude Indirect costs

[ oKk || Cancel || Heb

Cost and Allowable options

Cost and Allowables options allows for inclusion or exclusion of Variation orders in Cost and
allowable documents. Variation orders and Cost and Allowables will be covered in detail later.

Costs and Allowables options @

Calculation options

[ Include Forecast
[ Include Indirect costs

Inclusion of YO's in allowables

_ Criginal bill items only

@) Original bill tems and approved VO's
") Driginal bill tems and all VO's

OK || Cancel || Hep

Choose the Cost and Allowable options.

Note: These options may be changed later if required.

14
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Select the Bill Quantity

SelectNet rates

The Net Trade Summary is shown.

Post Tender Checks

Trade Total Display

Quartity selection
Bill Quantity

Rates

i@ Met
(7 Gross
(71 Selling

Bill Options
i@ Direct cost bill onhy
(7 Direct and Indirect costs
(7 Indirect costs only
General Options
[ Breakdown macros
Marked up rate breakdown
Print marcup coefficient

J [ concel

| oK Help

Trade Totals Display = = HEE
Q) View Tools AEL o
€203 - ventshaft & substation Contract 153810
NET TRADE TOTALS - Bi11 Quantity Thursday, 06 May 2010 12:01:14
TRADE DESCRIPTION NET AMOUNT |PLUGGED RATES Labour plant Material Temp Mats. overheads Prov Sums| Subcontract

E Earthworks 1,495,355.40 32,917.50 326,703.90 810,285.60 230,738.40 94,710.00| *
C Concrete 2,055,939, 30 375,642.30 284,454.90| 1,395,842.10

F Formwork 685,816.05 475,666.05 40,937.40 169,212.60

rR rReinforcing 298,123.67 72,745.37 225,378.30 3
B Brickwork 851,152.20 440,982. 60 410,169.60

W waterproofing 3,036.00 3,036.00

M metalwork 234,163. 80 116,660. 55 112,433.25 5,070.00 il
L Plumbing & Drainage 330,655. 80 138,513.19 6,884.62 127,504.09 6,427.95 51,325.95

m Mechanical 38,748.08 2,542.08 27,206.00 9,000.00

v Painting 51,207.90 51,207.90

Z provisional sums 51,250.00 51,250.00

GRAND TOTAL 6,095,448.20 32,917.50| 1,949,456.04| 1,101,625.12| 2,573,245.14 180,710.55 9,000.00 51,250.00 197,243.85| -

The Gross Trade Total and Selling Trade Total can be displayed using the sam T icon and
selecting the appropriate rate.
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Post Tender Valuations & Budget Control

3.2 Confidence Check

Checks the entire estimate and reports problems found.

Post Tender Checks

Unpriced or plug/split pricing codes, provisional items and resources, data copied from the master,

markup and selling rates are checked and recoded.

Do this:

In the Trade Totals Display cIick

Select Perform full error check with report | Confidence Check 5]

@) Perform full emor check with report
(7)) Quick check with counter display only

v)(x]

Pricing Modes
Unpriced 5 Worksheet 108
Plug Rate 1

Macro chains containing tems
Unpriced Mone Flug Rate

Waorksheets marked Provisional
Price codes | Mone Complex

Resounces
Provigional & Bx Master

Unpriced complex resources

Markup
Non Zero Individual Markup Zero mkup
Trade markup {non zero,/defined) Risk mkoup

Seling Rates
Zero seling Mone Mo selling 119 Gross differ

Bill ttems
Rate Only 1 Provisional

With no Price code allocated

Print

16




Job Size Display

Gives an overall listing of the job and is an important indicator for the time factor allocated to the
job.

Do this:
Click Check & Review > Job Size Display

oo e v =)
Number of Entries

Headings Resources

Price Codes
Direct Cost Pages
Direct Cost tems

Price code workshests
Complex Worksheets
Macro Worksheets

Indirect Cost kems

Mumber of Definttions

Global Variables Tax Codes
Cumency Codes

User Generated Files

Subcontract Adjudicators Take Offs
Subcontract Liabilities Areas
Material Adjudicators

System

Recoveny Bin

3.3 Selling Rate

At Tender Stage the: NetRate + Applied Mark Up = Gross Rate The gross rate is calculated based
on the net and mark up applied therefore any changes made on the net or applied mark up will
change the gross rate. This is ideal at tender stage but not ideal for the post tender stage of the
contract.

At the Post tender stage, a Selling Rate is available in Candy. The selling rate isused asthe
contractual rate for printing the Interim Payment Claim to the clien t. Adjusting the net or Applied
Mark Up will not affect the selling rates.

Therefore, for Post Tender Stage theNet Rate + Calculated Mark Up = Selling Rate

The selling is a fixed contractual rate by adjusting the Net (job remodelling) the Calculated Mark
Up will change.

One of the essential checks at post tender is to ensure that the job contains a selling rate. The
confidence check shows itemsthat do not have a selling rate therefore, the selling rate must be
entered or we can copy the Selling rate from Gross rate.

17



Do this:

Open the Document Manager by choosing Documents > Valuation Document Manager .

Valuation decument Manager ]
O Document  Edit View Teols Xéﬂj L))
Valuation Bills | Price codes I Resources I Indirects I Costs & Nlowablesl
Valuation Bill documents
I3 1. Valuation Bills -
1.2 Selling Bill of Cuantities
1.3 Valuation bill with Codes and Factors
3 2. Valuation input
2.1 Valuation Input - Actuals
2.2 Primary Valuation Entry
M 2.3 Master Valuation bil
@ 3. Valuation Comparisons and Trends
3.2 Remaining GQuantities and Values _
3 4. Valuation - Analysis 1
4.1 Resources per Bill item
4.2 Cost codes per Bill tem
4 5 Claim Review
4 7 Valustion amounts & quantties by code
@ 5. Costs to complete
5.1 Bill with cost rates for cost w/s adjustment
@ 6. Subcontract Adjudication
.1 Subcontract Package allocation
@ 7. Subcontract Manager
7.1 Bill with Subcontract allocation -
Shift+Enter for Master New document ] [Customise] [Seled]
Now open document 1.1 Gross to Sell Bill
1.1 Gross to Sell Bill = = EEEE
Q@ Edit View Tools Valuation 1: Fri 25.Jun 2010 RALQOXAEIS @
Net Markup® Res Gross Selling
L ltem Bill description Bill gty Rate Amount % Type Risk % Rate Amount Rate Amount Affributes
=h VENTILATION SHAFT & SUBSTATION CONTRACT 6.095.44820 6.857.68951 0 -
=] SECTION 2 VENTILATION SHAFT 4,069.081.90 4579.408.92 0 i
=3 SCHEDULE NO.1: FAN FOUNDATION 4030.333.82 4.535668.69 0
=4 EARTHWORKS 1.014,838 50 1.129.092.30 0
A Clear and strip site \5.400m2 399 21546.00), 10.000|Trade 439 23,706.00 0.00|PT
B Excavate in bulk, Class A material and dispose | 10,800m3 40.24 434,592.00; 10.000|Trade 1218 44.80 483,840.00 0.00WT%
within 2km freehaul distance
C Excavation in foundations ne 2m deep 1.125m3 3150 3543750, 10.000|Trade 1.079 3502 39,39750 0.00(ST%
D Excavate forworking space in Class A material  |660m3 2718 17.938.80); 10.000|Trade 1.177 3025 19.965.00| 0.00|WT3%
and backfill and compactto 95% mod. AASHTO
E Excavate in class A material for trenches and use |390m3 75.22 29,335.80 10.000 | Trade 1.183 8372 32,650.80 0.00WT%
for backdill. compact. and dispose of surplus
material
F Extra over all excavations in Class A material for  |315m3 82.00 25.530.00 10.000|Trade 9020 28413.00 0.00WT =i
Bill pags: 1 H4[1cf6 b B [Gotopage | [ Worksheet <] [ Calcuiate [

Note the selling rate column on the right side of the document. At Tender Stage the job was

priced and the Mark up was applied, the selling rates can now be established by copying the Gross
rate.

Right-click in the selling rate column header, selectCopy > Copy Selling rates from Gross
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Post Tender Valuations & Budget Control

Post Tender Checks

Right Click

Gross

——Rate————Amotrt—p-@ Rale

.39

6,857,689.51

4,579,408.92

4,535, 668.69

1,129,092_30

23.70R.00

B 8 SEE
DD N SR
Selling
Amount Aftributes
Sort 4 E
Filter.. 4
Group by.. 4
34 Find Ctrl+F L
| Lopy selling rate from gross |
Copy selling rates from master
Lock/Unlock selling rates 4
Multiply selling rates by factor..

Check the option to lock selling rates after copy and Copy zero gross rates click OKé

éand confirm

t he

Options

message.

- Transfer Gross to Seim

=

[T Ovenarite existing, unlocked selling rates

Copy zero gross rates

Lock selling rates after copy

OK

] [ Cancel

Help

J |

1.1 Gross to Sell Bill = = EHEE
@ Edit View Tools | Valuation 1: Fr 25 Jun 2010 ROQOXANLS 9
- Net Markup® Res Gross Selling
T L lem Bill description Bill gty Rate Amount % Type Risk % Rate Amount Rate Amount Affributes
_[=h VENTILATION SHAFT & SUBSTATION CONTRACT 6,09544820 6.857.68951 6.857.68951 =
_Ez SECTION 2: VENTILATION SHAFT 4,069,081.90 457940892 4579.408.92 E
_=3 SCHEDULE NO.1: FAN FOUNDATION 4,030,333.82 4.535,668.69 4.535,668.69
_ s EARTHWORKS 1,014,838 50 1.129.092.30 112909230
| A Clear and strip site 5.400m2 399 2154600, 10.000|Trade 439 23‘?06.00| 439 23706.00|PT L
[ B Excavate in bulk, Class A material and dispose | 10,800m3 40.24 434,592.00; 10.000|Trade 1218 44.80 483,840.00 44.80 48384000 WT% L
L within 2km freehaul distance ‘
: £ Excavation in foundations ne 2m deep 1.125m3 3150 3543750 10.000 | Trade 1.079] 35.02 39‘39750| 35.02 39.39750|ST% L
] D Excavate forworking space in Class Amaterial  |660m3 2718 17.938.80 10.000|Trade 1.177] 3025 19.965.00 3025 19.965.00(WT% L
L and backfill and compactto 95% mod. AASHTO ‘
N E Excavate in class A material for trenches and use |390m3 75.22 29,335.80 10.000|Trade 1.183 8372 32,650.80 8372 3265080 WT% L

for backdill. compact. and dispose of surplus
L material
: F Extra over all excavations in Class A material for  |315m3 82.00 25530.00f, 10.000|Trade 9020 28413.00| 90.20 28413.00(WT L =i
Bil page: 1 EEBEYE [Goto page | [ Workshest <] [ Calculate %)

Note the selling rates are displayed next to each bill item.
NB: Check the selling amount balances back to the signed contract document.

If the totals do not balance then go back to the problem bil | page and check the selling rate of

each bill item on that page.

19




Post Tender Valuations & Budget Control

Now open this document 1.2 Selling Bill of Quantities

Post Tender Checks

1.2 Selling Bill of Quantities =

c Edit  View Tools | Valuation 1: Fi 25 Jun 2010 CYCY @ @x @I 9

- Met Selling

Tl L tem Bill description Unit Bill gty Aftributes Rate Amount Markup® Rate Amount

_[=n VENTILATION SHAFT & SUBSTATION CONTRACT 609544820 6.857.689.51 ~

_Ep SECTION 2: VENTILATION SHAFT 4.069.081.90 457940892 =

=8 SCHEDULE NO.1: FAN FOUNDATION 403033332 453566869

|9 EARTHWORKS 1.014.838.50 1.129.092.30

1 A Clear and strip site m2 5.400|PT L 399 21546.00 10.025 4.39 23,706.00

T B Excavate in bulk, Class A material and dispose  |m3 10.800|WT% L 40.24 434.5592.00 11.332 44.80 483,840.00

|| within 2km freehaul distance

: C Excavation in foundations ne 2m deep m3 1125|ST% L 3150 3543750 11.175 35.02 3939750

T D Excavate for working space in Class A material  |m3 660(WT% L 2718 17.938.80 11.295 3025 19,965.00

|| and backfill and compactto 95% mod. AASHTO.

T E Excavate in class A material for frenches and use |m3 390|WT% L 7522 29,335.80 11.300 83.72 32,650.80
for backfill. compact and dispose of surplus

| material

O F Extra over all excavations in Class A material for  |m3 315|WT L 82.00 25.830.00 10.000 90.20 28.413.00

| Class B material

T G Filling under floors and around foundations in m3 11.520WT% L 3572 411.494.40 11.282 39.75 457,920.00
layers of 150mm, compacted to 95% mod

_ AASHTO 5

Bilpage: 1 | alTete pw | [Goto pags | [ Workshest |+ [Calouate |52)

Unlock & Lock the Selling Rate

The indicator in the selling rate column indicates that the rate is locked. To fix the rate
we must first unlock it.

Right click on the selling rate and select Lock/Unlock > Unlock selling rate

18

Ctrl+C
Ctrl+V

51

Lopy selling rate from gross

Copy selling rates from master

| Lock/Unlock selling rates

]

| Lock selling rates

77

Multiply selling rates by factor..

20
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Post Tender Valuations & Budget Control Post Tender Checks

3.4 Copy the final quantity from the bill quantity

Something to consider........

The bill quantity will normally be used for the first Final Value projection and as a starting point
can be copied to the Final Quantity column.

NOTE: I t 8 s hiblefere enterong athyvaltation quantities.
Do this:
Open the document 2.2 Primary Valuation Entry nt Actual | Actual
Right-click on the Final Quantity column header and i Fina™=* Sort A b
choose > Copy from selected quantity Filter.. b
Group by.. *
&4 Find Ctrl+F

Clear quantity
Quantity Decimalisation..
Multiply/Divide Quantity..

| Copy from selected quantity |
Calc-sheets »

Column layout.. Ctrl+FL
Column Help

| ™

Then slect the Bill Quantity as the source and confirm. SOURCE Select Quantity (=]

Final Quantity

Actual Guantity

Previous Actual Cty

Claimed Guantity

Previous Claimed City

Paid Quantity

Previous Paid Gty

Claim Bill Gty remaining  (Bill - Claim)
Claimed Gty remaining  (Final - Claimed)
Actual Gty remaining  (Final - Actual)
Varation Guantity  (Final - Bill)

User Gty (User defined)
]

d Copying quantities

. R : Copy Bill Quantity to Final Quartity for the selected tems?
Click YES . P & &
[] Overwrite existing items?

[ fes ] [ No
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Post Tender Valuations & Budget Control

And then OK the quantities copied.

Post Tender Checks

See that the Bill gty have been copied to the Final Qty

2.2 Primary Valuation Entry = 2 HEE
O Edit View Tools | Valuation 1: Fri 26 Jun 2010 [CRCN xHEg 9
- Previous Actual Previous Claimed Previous Paid Actual | Actual
Tl IL tem Bill description Unit Bill gty Actualgty  Quantty  Claim gty Quantity  Paid quantity  Quantity Final gty % Bill % Final |
_ =l VENTILATION SHAFT & SUBSTATION CONTRACT -
= SECTION 2 VENTILATION SHAFT ﬂ
=B SCHEDULE NO.1: FAN FOUNDATION
_|=a EARTHWORKS
A Clear and strip site m2 5400 5400
] B Excavate in bulk. Class A material and dispose  |m3 10.800 10.800
_ within 2km freehaul distance
: C Excavation in foundations ne 2m deep m3 1125 1125
—|[Erter data for this column on the top ine of record |

= Txvavaeorworngspace in Class A material — |m3 660 660

and backfill and compactto 95% mod. AASHTO
] E Excavate in class A material for trenches and use |m3 350 380
for backfill, compact, and dispose of surplus

_ material
1 F Extra over all excavations in Class A material for  |m3 315 315
_ Class B material
Bill page: 1 EEIECELR [Gotopage | [ Workshest [<%] [ Calculate [

Note: Later in the course the final gty will be re-measured using the quantity calc sheet.
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3.5 Check and review reports

Explanation

the tender .

Now Candy can generate a number of reports to help yowcheck for any possible problems on

To do a Pricing Check Report

Do this:

Go to Check & Review > Pricing Check

Select all price codes on Direct Cost bill
pages and select priced in plug and
priced in split.

Note: unused Priced codes should be
deleted before printing this report.

zasting ” Cashflow ” Valuations Materials

Check & Review  Finalisation Reports Subcontr:

Confidence check..

Job size display..
Date review.,

Pricing check (]
Provisional listings

Bill/Price code unit discrepancy check

Page/item checksum

Cross references..

Neimm mmAde Airdbeila e

Selection

@) Price codes on Direct Cost bill pages

Include codes
[ Priced at zero rate

() Price codes on Indirect Cost schedule Priced in plug mode

(7) Complex Resources

() Price codes in Price code list

Options

[7] Suppress printing codes in Unpriced mode

[7] Select Trades

Priced in split mode

[] With provisional worksheets
[ With no seling rate

[~ With zero seling rate

OK || Cancel || Help

C203 - Valuations & Commercial Management

Cc203 - Ventshaft & Substation Contract

PRICE CODE CHECK
Direct Cost Bill - R11 Trades

PAGE ITEM PRICING |DESCRIPTICN UNIT QUANTITY | MACRO QTY RATE | COMMENT
1l E1133 Site clearance mZ2 5,400.00 3.5%|Plug Mode
1l|c E42111 Exc fnd; ne Zm m3 1,125.00 31.50|sSplit Mode
4B E1133 Site clearance mZ2 2,850.00 3.59%|Plug Mode
4|C E42111 Exc fnd; ne 2m m3 600.00 31.50|split Mode

Plug Rate codes: 2
Split Rate codes: 2
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To delete unused price codes

Explanation

The Rice code list may contain price codes not used in the bill. You should consider deleting
unused price codes which will result in having a less confusing job. The job will therefore only
contain price codes used in the bill.

To delete unused price codes go to the document 1.1 Price Code Listing ()

and click Tools > Delete unused Price codes 1.1 Price code listing
iy Edit View | Tools

Brice code lists

14

Code List unused Price codes

3520 Delete unused Price codes

CR9R
& and cYEStocsenéirm the Price Code W)y Price code deletion
deletion ‘.C} Corfirm that you wish to delete unused Price codes

O
| Yes | | Mo |

Note: 12 unused price codes deleted. ‘:[j, Delete unused Price codes
é a 0K ‘IQF lUnused Price codes deleted: 12

b

o
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Similarly unused resource can also be deleted directly from the resource lis

Do This

Go to the document 1.1.Resource List ( ),

click Tools > Delete ALL unused resources > Delete Key resources as well

1.1 Resource List

{3 Edit View | Tools

Re

LIT| d
=1 [1

=2 n
0 1110
0 |11
0 1117

-
-

Usage calculation rules

List Resources L . .
Unit Final rate
List unused resources | |
Delete ALL unused rescurces Exclude Key resources from deletion
Delete Key resources as well i
Copy Master resources s = =

i Delete Unused resource headings
Import resources from file - J

F ™ T

And click YESto confirm deleting ALL unused resources

The list shows what unused resources were deleted.

Listing of unused resources - =N =

Q RAXAES @

§ Unused resources have been deleted -
11110 Planning Engineer /Month
11118 Land Surwveyor /Month |2
11125 Senior Quantity Surveyor /Month
11129 Chainboy /Month
17021 Insurance - PI Ssum

Unused Resource Code(s) found: 5

Goto
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Worksheet calc li ne check

Explanation

Checks for mistekes on worksheet calculation lines.If there is a space between +5%waste then
the wastage report would be incorrect. If *CONC] is used instead of *[CONC] the first
occurrence would be seen as a comment and not a variable if 1.09 is used instead of 1.09 tkn
1.00 instead of 1.09 will be used on the calculation line. Ensure accuracy at all times.

asting Cashflow Valuations Materials

Check & Review | Finalisation Reports Subcontr:

. . Confidence check..
Check & Review > Worksheet calc line check R EErclir by

Date review..

Pricing check

Prowvisional listings

Bill/Price code unit discrepancy check
Page/item checksum

Cross references..

Price code distribution
Trade distribution

Price code guantity analysis
Unallocated Project codes

Warksheet calculation line check

oresneet vanaole chec

. Worksheet Line Calculation Check @
Action

Reports on the following potential emors found on
waorksheet calculation lines:

1. Space between % and waste

Click OK. 2. [l not paired. eg “CONC]
3. O when 0 required. eg *1.08
How many errors were detected? 4. Calc Line starts with [ or numesic
i 5. Operator on Subtotal Line
If errors are detected a report will be generated. REres e e
Options

Separator character () embedded in calculation

Implied *1 on worksheet line

oK || canesl |[ Heb

Provisional Listings: Worksheets

Explanation

At tender stage the estimator may mark worksheets, resources and bill items as provisional.
Locate the provisional worksheets, resources and bill iems.

Check & Review > Provisional Listing

' Provisional Listings @

Choose Worksheets

i
In this example the check shows that no Provisional Worksheets were || © “/ersheets

found. H.es.nun::es
Bill tems
If errors are detected, a report will be generated. I:/‘:I
' o || K
e
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3.6 Value Analysis

Explanation

80/20 rule of thumb, identify which items contain the value and which items should be
concentrated on at pre and post tender stage.

Open the Valuation Reports by choosing

JEaIuationrs ” Materials ” Drawin
Reports > Valuation Reports Manager.

lisation = Reports | Subcontract  Areas

Si 1 &} | Valuation Reports Manager

Print the Value Analysis (68) report

Valuation Report Manager

(3 Report Edit View Tools XHaES e
Job Reports | My Reports

Job Valuation Reports

@ Valuation Bill of Quantities
@ Indirect Costs

Value Analysis (68)
Never printed
Type: Standard text report

Printer- Default printer
@ Costs and Allowables Paper: A4 (Partrait)
@ Resource Lists Layout - Fort size is 8.0pt

@ Trade Totals
@ Post Tender 5/C Control
(3 Valuations Bills
g Interim Payment Claim (54}
g Waluation Listings (65)
g Dual Cumrency Listing (67)
5 Value Aralysis (68)
@ Resource Analysis Reports
@ Project Codes Reports
@ Wastage Reports
@ Check and Review Reports
@ Worksheet Reporis

Mew report] [Customise] [F‘rirrt report IG]

and choose Final Quantity.

Select Quantity @

Actual Quartity
Claimed Guartity
Paid Quantity

User Gty  (User defined)
=D
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Select80% Percentage of total to be printed.

. Value Analysis A

Percentage

Percentage of total to be printed

Bill Selection

(@ Direct cost bill only

() Dlirect and Indirect costs
() Indirect costs only

Currency

(@ Pricing cumency

() Primary foreign cumency  Sterling
Cptions

[ Select trades

[ Select resource types
[ Print workssheets

[ ok || caneel ||

VALUE

=)
w

@ R

-

[ SIS

=}

W R -1 R
o oW Mo W

[ ]
o

"
0w

78

VALUE ANALYSIS 80%
Direct Costs Omly

Rl Trades
PRICING |DESCRIPTICN TNIT QUANTITY
R2e8 E/0 lomm HIS for bars of diz 25mm t 50 -102
C341 Conc Z0Mpa: Foundations m3 2,085 &31
B&&51 Cavity wall: Z x half brick skins mZ 2,010 zZ17
EZ20021 Bulk exc; cart off site m3 10,800 40
EBZZ45 Filling; 150mm layers; 35% mod m3 11,520 3
SE30013 |Exc fnd; ne Zm ;backfill, comp & disp (o2 5,480 7
BE341 1 stock brick wall: fnd mZ . 530 15
C3s580 Conc Z5Mpa: Surface beds m3 480 825
F3103 Expansion joints; vertical; Z0mm; ex. m 1,2e0 200
RZ40 HTS rebar: lémm dia. t 115 1,951
Fzls4 Fwk; foundations; wertical mZ 3,315 a7
C35Z0 Conc Z5Mpa: Walls m3 315 a3
MZ4656 M30 HD kolts; ex. 1250mm ne 1500mm kg 3,860 1
C825213 |Grouting; 1:3 dm3 17,325
Fz2z00 Fwk; wz2lls; wertical mE 1,770 =1
B7111 E/c bwk: facing & pointing mZ 1,980 50.42

TOTAL AMOUNT ANALYSED

-5,188

1,315,877

437,298
434,552
411,494
410,701
314,025
301,382

[
]
]

"

w
[ I

L]
Wk R
5]
L S
S

[

[
o

=1 =]

w

mok -

L
-1

moa
wom
"

-

[
w0
W

5,095,454
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3.7 Resource Checks

Resources can be checked for potential problems likeprovisional rates or out-dated rates.

Resource List with Date

Here we will alter a standard document to make a new Resource List with Date documentand
customise it.

Do this

Open the Resource Document Managerby choosing
VALUATIONS >Documents > Valuatio n document Manager .

Documents | Adjudicators  Indirec

@ | Valuation Document Manager

Valuation document Manager k3]

Select the Resourcestab to display @ Document Edit View Tools XHES @
the available resource documents.

| Valuation Bills I Price codes | Resources | Indirects I Costs &Nlowablesl

Resource documents

3 1. Estimating layouts
[Rl 1.1 Resource List
M 1.2 Master Resource List
1.3 Base rate, percentages, tax and cumency
1.4 Ltilisation and value - bill quantity
1.8 All codes and attributes
(3 2. Valuation layouts
2.1 Resource Group and Cost code allocation
2.2 Ltilisation and Value - Actual quantity
2.3 Resource list with cost rates

Shift+Enter for Master [New document] [Customise] [Seled]

Click the New Document button to New Heading
open the list of template documents New Sub-Heading
and choose 1. Estimating layouts 1.1 Resource List
1. Est|mat|ng IayOUtS >1.1 Resource — 2. Valuation layouts 1.2 Master Resource List

. New document 1.3 Base rate, percentages, tax and currency
List ; 1.4 Utilisation and value - bill quantity
Now right click on new 1.1 Resource List and rename it to dalustion document Mapagey

@ Document  Edit Yiew Tools
|\|"aluation Billz I Price codes | Resources | Indirects |

1.1a Resource list with Date

Resource documents

[[3 1. Estimating layouts
[Rl 1.1 Resource List
[1.12 Resource List with Date
Ml 1.2 Master Resource List
1.3 Base rate, percentages, tax and cumency
1.4 Utilisation and value - bill quantity
1.7 All codes and attributes
& 2_ Valuation layouts

To change the columns shown, clickCustomise
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Post Tender Checks

Explanation

arrow.

This is the column layout selector. To include column data into your document, you can move
available columns (left hand side) to the right with the green arrow; to remove them use the red

Add the column 4.2 Date of resource rate change and confirm.

Column layout: 1.1a Resource List with Date

Select the columns to be displayed on this document ..

Available

Selected

1 Resources

2 Rates and rate modifiers

3 Codes and Factors

4 Date Stamps
41 Date and inttials at creation
432 Date of resource rate change
4.3 Date and intials of last change

T

6 Usage

7 Waste

8 Usage amount
9 Waste amount
10 Escalation

44 Basze rate date and initials
5 Resources per Complex

| £ &

1
b

1
I

1.1
12
13
14
15
26
42

Heading level
Resource type
Resource code
Description
Uit

Final rate

Date of resource rate change

[ oKk

|| Cancel || Hep |

Now open your new document 1.1a Resource list with Date . Look for resources that have old

dates and check the rates.

1.1a Resource List with Date

& Edit View Tools

- Resource
TLlLlT Code Description
T 421313 Rawl Ties 200mm Long
T 44121 Scaffold Tube
=2 |49 " FUEL
M 4911 Petrol 95 Octane
M 4912 Petrol 97 Octane
M (4914 Diesel Hi Rate
=1 5 'PERMANENT MATERIALS
= 2| [0 " ALL OWANCES
M |50013 Imported Aggregates
M |50043 Jointing Material Allowance
=20 &1 " CONCRETE MATERIALS
= 3| [B11 " READY MIXED CONCRETE
M |51113 C10/19 Ready Mixed Concrete
M 51133 C20/19 Ready Mixed Concrete
M |51143 C25/19 Ready Mixed Concrete
= 3| [p12 " SAND
M |5121 River Sand
M |5122 Crusher Sand
M |5123 Filler Sand
M |5124 Plaster Sand
M |5125 Building Sand
= 3| [513 " CEMENT
M 51311 OPC Bulk 50kg
M 51312 0OPC Bags 50kg
M 51341 Slagment Bulk 50kg
M |51342 Slagment Bags 50kg

Resource usage calculation: Excludes Indirects, Includes waste

Unit
J/Each
Jm/Wk

JLtr
JLtr
JLtr

/Sum
/Sum

jm3
/m3
im3

im3
im3
im3
J/m3
im3

/bag
[bag
/bag
/bag

RAXNAES @

Final rate
7.50
0.75

6.20
6.50
6.30

1.00
1.00

450.00
550.00
625.00

68.00
72.00
65.00
75.00
60.00

37N
38.79
30.78
49

B & 5EE

Final rate

Changed
27 Apr10 |-
27 Apr 10

31 Mar 10
31 Mar 10
31 Mar 10

27 Apr10
27 Apr10

27 Apr10
27 Apr10 |
27 Apr 10

m

31 Mar 10
31 Mar 10
31 Mar 10
31 Mar 10
31 Mar 10

27 Apr10
27 Apr10
27 Apr10

27 Apr10 |~

[Go to... ] [Complex workshest I-G] [Calculate ]
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Sorting the resources by the date
The resources can be sorted by the date in ascending order.

To do this, right-click in the Final rate T
Final rate

changed column, select Sort > Ascending
Cha | Sort | Ascending |
Eilter.. k Descending
group D Custom Sort..

YR Find - —
1.1a Resource List with Date = = ==E
i3 Edit View Tooks BAxBAES @
- Resource Final rate
T IL T Code Description Unit  Final rate ||
| M 4911 Petrol 95 Octane fLitr 6.20(31 Mar 10 |«
| M 4912 Petrol 97 Octane fLitr 6.50|31 Mar 10
| M 4914 Diesel Hi Rate fLitr 6.30(31 Mar 10 |=
| M {5121 River Sand fm3 I 65.00|31 Mar 10
| M 5122 Crusher Sand fm3 M 72.00(31 Mar 10
| M 5123 Filler Sand fm3 ) 65.00|31 Mar 10
| M |5124 Plaster Sand jm3 " 75.00(31 Mar 10
| M 5125 Building Sand fm3 " 60.00|31 Mar 10
| O 111m Project Manager [Maonth 50,000.00|27 Apr 10
| O (11104 Site Agent /Month 35,000.00|27 Apr 10
| O (11110 Planning Engineer Maonth 30.000.00|27 Apr 10
| 0 {11114 General Foreman Maonth 25,000.00|27 Apr 10
| O {11115 Trades Foreman Maonth 17.500.00 |27 Apr 10
| O (17 Engineer Maonth 30.000.00|27 Apr 10
| O (11118 Land Surveyaor [Maonth 28,500.00|27 Apr 10
| O 11125 Senior Quantity Surveyaor [Maonth 37.500.00|27 Apr 10
| O 11126 Quantity Surveyar [Maonth 30,000.00|27 Apr 10
| O 11129 Chainboy [Maonth 3.500.00127 Apr 10
| O 11132 Contracts Administrator [Maonth 5,000.00|27 Apr 10
| 0 {11133 Senior Clerk Maonth 4.,500.00|27 Apr10
| 0 {11134 Typist/Receptionist Maonth 4,000.00|27 Apr10
| 0 {11140 Storeman Maonth 3.000.00|27 Apr10
| O 1141 Tea [ Cleaning Week 600.00(27 Apri0 |~
Resource usage calculation: Excludes Indirscts, Includes waste [Goto... | [Complex worksheet [ | | Calculate |

. . SorTooter 0l
When you are finished you can clear the sort with I
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Provisional resources

If you move the pointer over the red dots on the Final rate, you will notice that these are marked as

provisional, like this:

B Frovisional
Base rate

Alternatively, a fixed filter can be used to find resources that where marked as provisional.

11a Resource List with Date

(3 Edit View Tools

View level 4
T |L 1+ DisplayFinal when no Cost rate
$ Sort 3
T Filter..
T Group by.. L4
= 2
I Font size 4
E Column layout.. Ctrl+F1
=1 Resize & Position 4
= 2 50 ALl OWANCES
M 50013 Imported Aggregate
M 50043 Jointing Material Al
= 2 5 " CONCRETE MATER
=3 a1 " READY MIXED CO
M 151113 C10/19 Ready Mi
M 151133 C20/19 Ready Mi
M |51143 C25/19 Ready Mi

Description

Resource type
Resources that are simples

Resources that are complexes

Provisional resources

Key resources

Unchanged raster resources
Resources with base rates

Resources with cost rates

Resources with materials on site gty

Boot complexes

Blank codes

LI
LI

LS ]

Select the document menu View > Filter > Provisional Resources

Note : Filter toolbar 66 60 i

Filter Toclbar - &

(=]

[Abandon] [Show rejects] [Hide headers ] [Invert] [Select ]

ndi

cati

ng 6 fi

QAXAES ©

Final

450.00 |27 Apr 10
550.00|27 Apr 10

625.00|27 Apr 10

|l tered

You can now show justthe resources you want with | Hide rejects

1.1a Resource List with Date
i3 Edit View Tools

- Resource
Tl T Code Description Unit
=1 [s 'PERMANENT MATERIALS
= 2| s " CONCRETE MATERIALS
= 3| 512 " SAND
M |5121 River Sand /m3 "
M (5122 Crusher Sand /m3 "
M |5123 Filler Sand /m3 "
M (5124 Plaster Sand /m3 "
M |5125 Building Sand fm3 "
= 3| |514 " STONE
M (51413 19mm Aggregate /m3 "

Resource usage calculation: Excludes Indirects, Includes waste

RAXAES @

Finalrate Changed

68.00
72.00
65.00
75.00
60.00

120.00

B = =EE

Final rate
rate  Changed
1.08|27 Apr 10 | -
5.01|27 Apr 10
7.50|27 Apr 10
0.75|27 Apr 10

6.20(31 Mar 10
6.50(31 Mar 10
6.30(31 Mar 10

27 Apr 10
27 Apr 10

[==]
I==]

provisional

B = SlEE

Final rate

31 Mar 10
31 Mar 10
31 Mar 10
31 Mar 10
31 Mar 10

m

27 Apr10

-

[Go to.. ] [Complax workshest IG] [Calculate]

On the filter toolbar, click
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Resource percentage report

Value Analysis canbe performed on resources to identify which resources contain the value and
which resources should be concentrated on at pre and post tender stage.

Open the Valuation Reports by choosing VALUATIONS >Reports > Valuation Reports Manager

: Mew report
C“Ck Select8. Resource 1. Valuation Bill of Quantities

Analysis Reports > 8.5 Resource 2. Indirect Costs

3
3
percentage (74) 3. Costs and f\llnwables 3
4, Resource Lists »

3

3

3

3. Trade Totals

6. Post Tender 5/C Control
7. Valuations Bills

| 8. Resource Analysis Reports 8.1 Valuation Resource Analysis (70)

9. Project Codes Reports 4 8.2 Resources by Bill Itern (71)

10. Wastage Reports L4 8.3 Analysis by Group/Cost (72)

11. Check and Review Reports P 8.4 Valuation Production Rates (73]

12, Worksheet Reports 4 | 8.5 Resource Percentage (74)

MNew report 8.6 Resource Group,/Cost Summary (75)
8.7 Group/Cost Analysis (76)
. Resource Percentage Report
Select Primay sort by Resource type 2SR 2]
Primary Sort by

(71 Resource group
(7 Resource cost codes
@ Resource type
(7 None (sort by value only)
Selection
@ Simple resources only
() Simple and complex resources
Oiptions
Include Indirect costs
[ Print zero utilisation

Suppress resources below .
of the total *
| OK || Cancel || Hep |

| Select Quantity @

Select Final Quantity
Actual Guantity

Claimed Guantity
Paid Cuantity

v][%]
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RESOURCE PERCENTAGE REPORT

Based on Final Quantity (Rands)
LEVEL |CODE RESCURCE NEME THNIT LTTR UTILISATICHN BATE AMOUNT| % TY¥PFE| % TOTAL
Labour
L 2331 Basic Rate /Sum E 1,445,288.17 1.00 1,445,268.17 74.14 23.71
2394 Pension Scheme f5um E 183,396.73 1.00 183, 396.73 3.44 3.02
1300 Travel Allowance /Sum E 144,227.34 1.00 144,227.34 7.40 2.37
2333 Holiday Fund f5um E 54,254 80 1.00 94,254.80 4.83 1.55
2332 Wca f5um E 25,820.14 1.00 25,820.14 1.32 0.4z
2338 Sick Fund fSum E 15,151.82 1.00 1%,151.82 0.38 0.31
2385 Levies & Registration fSum E 15,151.82 1.00 1%,151.82 0.38 0.31
18Z0 Inclement Weather SSum &,153.71 1.00 &,1532.71 0.32 0.10
Labour 1,938,024.53 31.79
Plamt
B 325111 JD 410 Digger Loader fHour 2,532 .40 185.00 433, ,818.530 4483 8.10
33511 CMZ0 Pan Compactor fDay 150.03 T15.00 107,271.59& 5.74 1.7a
31711 &m3 Tipper fDay 143 .20 &75.00 9&,730.02 8.78 1.53
33421 Dynapac 5T&0 Roller /Day 113.42 747.50 24,777.98 7.70 1.29
35131 21/14 Mixer /Day 217.52 2B2.50 83,202.54 7.585 1.36
31521 0_75m3 Dumper fDay 217.52 2B1.25 &1,178.34 5.55 1.00
35532 Cement Sile 100t /Day 217.52 200.00 43,504.60 3.35 0.71
3542 Boomscraper Fl14 fDay 217.52 200.00 43,504.60 3.85 0.71
3556 Screw Conveyor /Day Z217.52 112.00 24,3682.57 2.21 0.40
1810 Batch Flant Establishment fSum 16,475.01 1.00 16,475.01 1.50 .27
3171z &m3 Tipper Em Levy JEm 3,256.30 3.38 11,008.33 1.00 0.15
3001 Site Transport Rllowance SSum 1,088.75 1.00 1,088.75 0.10 0.0z
Dlant 1,088, 337.80 17.50
Material
M 51311 OPC Bulk 50kg fbag 15,6687.01 37.91 533,336.45 z3.08 5.74
514132 15mm Aggregate fm3 B 2,934 24 120.00 35Z,108.88 13.88 5.78
4314 Diesel Hi Rate fLtr 41,450.8 €.30 281,140.45 10.15 4.28
5131z OPC Bags 50kg /bag 5,842.14 33.739 232,458.88 5.02 3.8l
53411 Face Bricks fThou 226.5 315.92 207, 466.87 .06 3.40
53111 Stock Bricks /Thou 208.8 750.75 158, 630.59 §.09 2.57
60323 High Tensile Steel (R1l Sizes) /Tomne 115.4 300.00 155,252_54 &.03 2_55
5121 Biver Sand fm3 =y 1,820.5 &8.00 123,738.45 4.81 2.03
51342 Slagment Bags S0kg /bag 1,812 .7 34.91 63, 284.22 Z.48 1.04
T1Z375 375mm 750 Ogee Concrete Pipe flm 333.1 155.00 &0, 338.25 Z2.37 1.00
&033153 |Mesh Reference 133 Sm2 2,915.2 20.40 55,471.10 2.31 0.93
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Chapter 4. Pricing using Worksheets

Plug rates and split rates must also be converted to Worksheets to generate the required resource
budget.

4.1 Price Code

Price code s and how they work
The Price codeds function is to deal wi th t

To rate a bill item, a Price Code is entered against it and the bill item adopts the rate from the
Price Code(regardless of whether it was generated by plug rate, split rates or worksheet).

The Price code can be up to 8 alphanumeric characters in length. The first character of the Price
Code must start with a Trade Code letter and the rest of the code is entirely up to you.

Note that the Price code has its own Description. The description of the bill item is totally
independent of the Price code description. Therefore, one Price Code may be used for multiple
Bill Items effectively speeding up the pricing process.

4.2 Price Plug and Split Rate items using Worksheets

The pricing check report printed earlier listed Price code E1133 as a Plug rate and Price code
E42111 as Split rate.To control your allowable the plug rate and split rate must be priced using
worksheets.

C203 - Valuations & Commercial Management C203 - Ventshaft & Substation Contract
PRICE CODE CHECK
Direct Cost Bill - A1l Trades
PAGE ITEM PRICING |DESCRIPTION UNIT QUANTITY | MACRO QTY EATE | COMMENT
1A E1133 Site clearance mZ2 5,400.00 3.59%|Plug Mode
1|c E42111 Exc fnd; ne Zm m3 1,125.00 31.50|8plit Mode
4R E1133 Site clearance m2 2,850.00 3.99|Plug Mode
4/C E42111 Exc fnd; ne Zm m3 600.00 31.50|5plit Mode

Plug Rate codes: 2
Split Rate codes: 2

The list of price codes for the job can be displayed by clicking on the
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Do this

Go to document 1.1 Price code listing

Pricing using Worksheets

Note: Price code document lists all the Price codes available in the job in Alpha numeric order.

1.1 Price code listing
i3 Edit View Tools

5 & BB
RAXKES @

- Price code Total net bill
M Code Description Lnit Quantity Rate Met amount  Atftrib
| |C7862 Conc 20Mpa: Benching m3 1.026.50 [Rate only WT% |-
_ | 825213 |Grouting; 1:3 dm3 17.925.00 599 10737075 |WT% L
| Tes0 Wood float m2 3.405.00 645 2196225\WT% L |-
| 133 Site clearance m2 8250000 | 399 3291750(PT L %
_ | [E20021 Bulk exc; car off site m3 10.600.00 40.24 43459200 WT%L |
| [E3251 Exc trenches; ne 2m m3 17.90(Rate only WT%
| 42111 Exc fnd: ne 2m m3 1.725.00 31.50 54.33750(5T% L
| [E52003 Exc working space; 95% mod m3 660.00 2718 17938.80 WTS% L
] E603 E/o exc: hard material ma3 1.155.00 82.00 94 71000 WT L
| [EB70 Disposal; excess of freehaul m3.km 21,600.00 1.79 38,664.00(WTS% L
| |E670a Stockpile: on site m3.km 0.44 |Rate only WT% L
| E7811 Exc manholes m3 107.47|Rate only WT%
| [E8110 Exc: keep free of water Sum 1.00 Included WT L
| [E8121 Load & dispose surplus m3 2234 |Rate only WT%
_ | E82245 Filling: 150mm layers; 95% mod m3 11.520.00 3872 41149440 WT% L
| [E8251 Backfill & compact, 90% mod m3 2742 |Rate only WT% |~
[Goto..|[ Workshest |[%][Calculate |
Price Code E1133 using a Worksheet
Price Code E1133Site clearanceis plugged. Total net bill
Right click in the rate and select Display Quantity Rate Netamount = Afirib
worksheet . 3.405.00 2196225|WT% |~
8.250.00 32917501PT
10.800.00 4024/ [ Copy
17.30 3 Paste
1.725.00 31.50
660.00 2718 | Display worksheet..
€ to show the Pri codeds worksheet
E1133 Price code workshest + = B 5E=E
& Edit View Tools XAaAES o
E1133 |Site clearance 8,250 \m2 |Seling Rate: 4.39 [Total Rate: 0.00
A Clear and strip site 2,850 m2 Plug Rate mode
1A Clear and strip site 5,400 m2 Stored:;
Recalc: 20 Apr 10
MacroQty: 0.000|
Line 4of 0 | Tracking: Price code order E@[ Insert a w/s IG] [Ccmplax w;’s] [Stcre workshest IA]
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About Worksheets

315 Calculation lines are available to calculate the net rate for the price code. The worksheet
header displays Price code, Pricing descrip
headeralsodi spl ay where the price code is used i
Therefore the change in rate for the price code will change the rate on the items where the price
code is used.

Note: A calculation must start in the beginning of the li ne using a resource code. Beginning with
a space will only create a comment line.

Do This

To add the required resources to the worksheet from the Resource List,type resource codes
32511

3171

2211

é a the beginning of calculation lines 2, 3 & 4.
The workshed fetches the resources from the Resource List.

E1133 Price code workshest + = B 5E=E
& Edit View Tools ¥XAaEgS @
E1133 Site clearance 8,250 | \m2 Selling Rate: 435 |Total Rate: 3,860.38
A4 Clear and strip site 2,850 m2 Plug Rate mode L - Labour: 530.10
1A Clear and strip site 5,400 m2 Stored:; P - Plant; 2,419.07
Recalc: 20 Apr 10/ |M - Material: 911.21
MacroQty: 0.000
32511 JD 410 Digger Loader W&O 2362.000/Day = 2,362.00
317 6m3 Tipper W&O 1337.177/Day = 1,337.18 _
2211 Labourer 161.200,/Day = 161.20 =
Line 5of 4 | Tracking: Price code order EIII | Insert a w/s |E| |Comp|ex wi's | [ Store worksheet [q

Now multiply each resource by the required number. Type in the multipliers:

32511 JD 410 Digger loader *1off
3171 6m3 Tipper *20ff
2211 Labourer *40ff
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Pricing using Worksheets

E1133 Price code worksheet + = B oEE
& Edit View Tools xaEs o
E1133 Site clearance 8,250 |m2 Selling Rate: 439 |Total Rate: 5.681.16
418 Clear and strip site 2,850 m2 Plug Rate mode L - Labour: 1,198.15
1A Clear and strip site 5,400 m2 Stored:; P - Plant; 3,170.89
Recalc: 20 Apr 10/ |M - Material: 1,312.12
MacroQty: 0.000|
32511 JD 410 Digger Loader W&O 2362.000/Day*1off = 2,362.00
317 6m3 Tipper W&O 1337.177 /Day*20ff = 2,674.35 _
2211 Labourer 161. 200/Day*4off = 644.80 =

Line 5of 4 Tracking: Price code order

E@[ Insert a wi's I-G] [Comple:(w;’s] [Storeworlﬁheet IA]

Start an applied factor u s i #Ogrocalculationlinel. End t he

by the calculation *0.5day/710m2 .

E1133 Price code workshest & B = =EE
(3 Edit View Tools xAaES o
E1133 Site clearance 8,250 |m2 Selling Rate: 4.39 |Total Rate: 5,681.16
ciy Clear and strip site 2,850 m2 Plug Rate mode L - Labour: 1,198.15
A Clear and strip site 5,400 m2 Stored: P - Plant: 3,170.89
Recale: 20 Apr 10| [M - Material: 1,312.12
MacroQty: 0.000
# -
32511 I 410 Digger Loader W&O 2362.000/Day*1off = 2,362.00
3171 em? Tipper W&O 1337.177 /Day*2off = 2,674.35 ¢
2211 Labourer 161. 200/Day*4off N 644. 80

=*0. 5day,/710m2|

Line 5of 4 | Tracking: Price code order

-

E]E][ Insert a w.'s IG] [Complexw;"s] [Storeworksheet IA]

appl i=éfdllofed ct or

Note: The Enter key or moving off the line
OAPPLIED FACTORwill appear.

will automatically calculate the result and the words

E1133 Price code worksheet & == EE
@ Edit View Tools xaEg o
E1133 Site clearance 8,250 m2 Selling Rate: 4.39 [Total Rate: 3.99
A Clear and strip site 2,850 m2 Plug Rate mode L - Labour: 0.64
1A Clear and strip site 5,400 m2 Stored: P - Plant: 223
Recale: 20 Apr 10| [M - Material: 0.92
MacroQty: 0.000
# -
32511 I 410 Digger Loader W&O 2362.000/Day*1off N 1.66
3171 em? Tipper W&O 1337.177 /Day*2off N 1.88 =
2211 Labourer 161. 200/Day*4off N 0.45
= APPLIED FACTOR *0. 5day,/710m2 3.99—

Line 6of 5 | Tracking: Price code order

—

E]E][ Insert a w/'s IG] [Cornplexw;"s] [Storeworksheet IA]

Use the shifted function E] on the Store & next w/s function

button to change the store mode from

Store & Next worksheet to Store & return to document.

Click Store Worksheet

This message will offer to change it from
Plug Rate mode to Worksheet mode.

v  Store & next worksheet
| Store & return to document |
Store & next unpriced worksheet

s |<+| | Complexwi/s | | Store dnexdtw/s [+

‘.d This Price code is in Plug Rate mode. Do you want to change it
‘u to Worksheet mode?

qu fes ] [ Mo
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Click YESto change to worksheet mode and OK to store the worksheet.

«Jy Storing worksheet
‘.E} WARMING: This Price code has a Selling rate

.
[] Switch off the message for this session?

Price Code E42111 using a Worksheet

The Price CodeE42111 Exc fnd; ne 2m is Split.

Right click in the rate and select Display worksheet

E42111 Price code workshest

@ 8= EEE

) Edit View Tools xaEg o
E£2111 Exc fnd; ne Z2m 1,725/m3 Selling Rate: 35.02 |Total Rate: 0.00
4HC Excavation in foundations ne 2m deep 600 m3 Split Rate mode
1C Excavation in foundations ne 2m deep 1,125 m3 Stored:

Recale: 20 Apr 10/

MacroQty: 0.000

o~

line 10f 0 | Tracking: Prics code order [4][» ] (insettawrs [<) (Complexw/s | [Store workshest [
Note
The worksheet header displays the totdtémQand c

1125m3 on Page 1/Item C.

E42111 Price code worksheet
i3 Edit View Tools

Typing the resource coderequires knowing the

E42111 Exc fnd; ne 2m
correct Code_ 4/C Excavation in foundations ne 2m deep
1C Excavation in foundations ne 2m deep
Ifyoudond6t know t h eaddacedorrcey o
by right -clicking on the calculation line and
choosing Resource list. .
Delete line Ctrl+Del
Insert line Ctrl+Ins
Clear to end of line Ctrl+End
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Selectthe resource 32511 JD 410 Digger Loader W&O 6

Job resources

=

32 PLANT - EXCAVATION
3221 Komatsu PC150 W&0
322111 Komatsu PC150

32511 JD 410 Digger Loader WO
325111 JO 410 Digger Loader

33 PLANT - EARTHWORKS
342 Dynapac ST&0 Roller Wa0D
33421 Dynapac STED Roller

3351 CM20 Pan Compactor WaD
3351 CMZ0 Pan Compactor

35 PLANT - CONCRETE
3513 21/14 Midng Plant

35131 21414 Mixer

3h42 Boomscraper F14

3583 Cement Silo 100t

3556 Screw Conveyar

s

Hip Job/Master E

and to add the resource to the w/s calculation line.

Pricing using Worksheets

M ace the cursor on the next calculation |ine

E42111 Price code worksheet * m @ gEE

) Edit View Tools Vel ERY)

E4£2111 Exc fnd; ne Z2m 1,725/m3 Selling Rate: 35.02 |Total Rate: 252320

4IC Excavation in foundations ne 2m deep 600 m3 Split Rate mode L - Labour: 34565

1C Excavation in foundations ne 2m deep 1,125 m3 Stored: P - Plant: 1,667.25
Recale: 20 Apr 10| [M - Material: 510.30
MacroQty: 0.000

32511 10 410 Digger Loader W&O 2362.000/Day = 2,362.00

2211 Labourer 161, 200/Day e

Line 4of 3 | Tracking: Price code order

161.20

-

ED

Insert a w.'s IG] [Complex wi's ] [ Store workshest IA]

Multiply each resource by the required number.

32511 JD 410 Digger loader
2211 Labourer

E42111 Price code worksheet

*10ff
*20ff

¢ 8= EEE

9 Edit View Tools xaEs o

E42111 Exc fnd; ne Zm 1,725|/m3 Selling Rate: 35.02 |Total Rate: 268440

4iC Excavation in foundations ne 2m deep 600 m3 Split Rate mode L - Labour: 506.85

il Excavation in foundations ne 2m deep 1,125 m3 Stored: P - Plant: 1,667 25
Recalc: 20 Apr 10/ |M - Material: 510.30
MacroQty: 0.000

32511 JD 410 Digger Loader W&O 2362.000/Day*1off = 2,362.00

2211 Labourer 161.200/Day*2off = 322.40 =

Line 4 of 3 Tracking: Price code order

E@[ Insert @ w/s IG] [Comple:( w;’s] [Storeworksheet IA]

Price worksheet using the goplied factor applying a production of 86m3/day and adding 10% for

battering.
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E42111 Price code worksheet Created: E 06/05/2010

Pricing using Worksheets

@ 8= EEE

) Edit View Tools xaEg o
E42111 |Exc fnd; ne 2m 1,?25|rn3 Selling Rate: 35.02 |Total Rate: 2,684.40
4/C Excavation in foundations ne 2m deep 600 m3 Stored: 06 May 10| |L - Labour: 506.85
1C Excavation in foundations ne 2m deep 1,125 m3 Recalc: 06 May 10| |P - Plant: 1,667.25
MacroQty: 0.000| |M - Material: 510.30

# -

32511 1D 410 Digger Loader W&O 2362.000/Day*1off = 2,362.00 |

2211 Labourer 161. 200/Day*2off N 322.40 =

=/85m3/day+10% for battering

Line 4of 3 | Tracking: Price code order |

-

E]E][ Insert a w/'s IG] [Complexw.—’s][&mevmdd’iea‘. IA]

BN

The net rate 34g46cal cul at ed o O
E42111 Price code worksheet Created: E 06/05/2010 Amended: E 06/05/2010 b | E
) Edit View Tools Vel R
E£2111 |Exc fnd; ne 2m [ 1,725/m3 Seling Rate: 35.02 Total Rate: 3474
4/C Excavation in foundations ne 2m deep 600 m3 Stored: 06 May 10| |L - Labour: 6.56
1C Excavation in foundations ne 2m deep 1,125 m3 Recalc: 06 May 10| |P - Plant: 21.58
MacroQty: 0.000| |M - Material: 6.60/
# -~
32511 I 410 Digger Loader W&O 2362.000/Day*1off N 30.57 |
2211 Labourer 161. 200/Day*2off N 4.17 &
= APPLIED FACTOR /85m3/day+10% for battering 34.74

Line 5of 4 | Tracking: Price code order |

-

E]E][ Insert a w/s IG] [Cornplexw.—"s] [&mevmdd’ied IA]

Click \Store worksheeli

Click YESand store the worksheet.

This Price code is in Split Rate mode. Do you want to change it
to Worksheet mode?

fes ] [ No
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Chapter 5. Value Engineering (or Re-modelling)

Purpose of Value Engineering

The site team can now re visit each of the worksheets and adjust the productions to what t hey
will achieve on site. Better buying, better S/C rates are taken into account, the site team agrees
on the productions in the worksheets and relooks at the construction methods used.

By doing this, the site team takes ownership of the tender and any losses cannot be blamed on
the estimating department. By remodelling, the site team could have more financial gain with
productivity and innovation making a profit from better buying and alternative construction
methods.

Macro price codes must also be exploded so that progress quantities may be entered.

5.1 Job Remodelling

Let 0s

Resource List

Open resource document 1.4 Utilisation and value

assume t

1.4 Utilisation and value - bill quantity
i3 Edit View Tools

-
-

nRGEnRERERE

[ L e perpr—

+ [

-

T

===

Resource
Code

Description
RELIMINARIES
OUR

FORMWORK
FUEL

Petral 95 Octane

Petral 97 Octane

Diesel Hi Rate
ERMANENT MATERIALS
T-IN MATERIALS
& EMATERIALS
HOLE FINISHES
UBCONTRACTORS

Resource usage calculation: Excludes Indirects, Includes waste

he si

B/d.imennsteaid 0f16.3/ pitter c h a s e

d bill quantity
Unit Final rate
JLir 6.20
JLir 6.50
JLir | 6.30

di

B e =EEE

RAXAES ©

Bill quantity

Usage Amount
17726503
1.804.514 25
1.106.099.89
47199547
18067781
29131766
1.800.37 11.162.29
44.469.11 280.155.37
1.855.997.81
33965351
96.46025

24849385

Bill gty
Man Hours

a~

94.452

m

-

|Go to... | |Con1p|ax worksheet |E| |Ca|c:|.||ate
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Adjust the diesel rate accordingly and click Calculate

1.4 Utilisation and value - bill quantity
3 Edit View Tools

- Resource
TLlLT Code Description
1 1 RELIMINARIES
1 2 OUR
1 3 LANT
= 1 4 EMPORARY MATERIALS
2 40 FORMWORK
= 2 49 FUEL
M 4911 Petral 95 Octane
M |4912 Petral 97 Octane
M (4914 Diesel Hi Rate
1 b ERMANENT MATERIALS
1 [ T-IN MATERIALS
1 7 & EMATERIALS
1 3 HOLE FINISHES
1 9 UBCONTRACTORS

Resource usage calculation: Excludes Indirects, Includes waste

Unit

fLtr
JLtr
JLir

Final rate

6.20
6.50
6.00

Bill quantity

Usage

B e =EEE
QRAXKEI @

Bill gty

Amount Man Hours

1.800.37

44.469.11

17726503
1.804.51425
1.106.099.89

458 654 74

18067781

27797693

11.162.29

266.814.64
1.855.997.81
33965351
96.46025

24849385

94.452

-~

m

-

[Go to...] [Complex worksheet IG] [Calculate

Note that th e Diesel allowable decreases from280 155.37 to 266 814.64 representing a buying
saving of 13 340.73.

Trade Totals Display

Tt

Do a Trade Totals Display onSelling at 6.3/Ltr of Diesel.

Trade Totals Display = = 5EE

Q View Tools HEs @

€203 - ventshaft & Substation Contract - ch 5 195544

SELLING TRADE TOTALS - Bi11 Quantity Thursday, 06 May 2010 14:02:05

TRADE DESCRIPTION SELLING AMOUNT Labour Plant Material Temp Mats. overheads Prov sums| Subcontract MARKUP

E Earthworks| 1,662,844.20 333,727.84 831,249. 86 241,001.33 94,710.00 162,155.17 | ~

¢ concrete 2,325,575.40 375,544.00 284,444.24| 1,295,720.98 269,866.00

F Formwork 769,052.70 475,645.19 40,931.10 169,179.70 83,296.71

R Reinforcing 338,610. 64 72,739.41 225,379.31 40,491.92 | =

B Brickwork 964,181.10 440,969.26 410,178.45 113,033.39

W waterproofing 3,456.00 3,036.00 420.00

M Metalwork 265,077.60 116,622.98 112,431.06 3,070.00 30,953.56| —

L Plumbing & Drainage 372,438.59 138,309.43 ©,884. 80 127,504.57 6,428.10 51,325.95 41,785.74

m mMechanical 43,740.23 2,542.09 27,206.00 9,000.00 4,992.14

v painting 56,338.05 51,207.90 5,130.15

Z pProvisional sums 56,375.00 51,250.00 5,125.00

GRAND TOTAL 6,857,689.51| 1,956,300.29| 1,122,578.90| 2,583,388.80 180,677. 80 9,000. 00 51,250.00 197,243.85 757,249.87 | ~
Corfidence check

The tender rate for Diesel at 6.3/Ltr calculates Material Net Amount of 2 583 388.80 and a Markup

of 757 249.87

Do a Trade Totals Display onSelling at 6.00/Ltr of Diesel.

Trade Totals Display = = EEE

Q) View Tools YR

€203 - ventshaft & substation Contract - ch 5 195544

SELLING TRADE TOTALS - Bi11 qQuantity Thursday, 06 May 2010 14:03:03

TRADE DESCRIPTION SELLING AMOUNT Labour Plant Material Temp Mats. overheads Prov sums| Subcontract MARKUP

E Earthworks 1,662,844.20 333,727.84 831,249. 86 230,056.62 94,710.00 173,099.88| ~

C Concrete 2,325,575.40 375,544.00 284,444,.24| 1,393,396.78 272,190.29

F Formwork 769,052.70 475,645.19 40,931.10 169,179.70 83,296.71

R Reinforcing 338,610.64 72,739.41 225,379.3 40,491.92 | =

B Brickwork 964,181.10 440,969.26 410,178.45 113,033.39

w waterproofing 3,456.00 3,036.00 420.00

M Metalwork 265,077.60 116,622.98 112,431.06 5,070.00 30,953.56|

L Plumbing & prainage 372,438.59 138,509.43 6,884. 80 127,432.76 6,428.10 51,325.95 41,857.55

m Mechanical 43,740.23 2,542.09 27,206.00 9,000.00 4,992.14

v Paintin 56,338.05 51,207.90 5,130.15

Z Provisional sums 56,375.00 51,250.00 5,125.00

GRAND TOTAL 6,857,689.51| 1,956,200.29| 1,122,578.90| 2,570,048.08 180,677.80 9,000.00 51,250.00 197,243.85 770,590.59| -
Corfidence check
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The Diesel at 6/Ltr calculates Material Net Amount 2570 048.08 and a markup is now higher at

770590.59. An increase in markup of 13 340.72

Now return to page one of the Bill of Quantities

Do this:
Open document 1.1 Gross to Sell Bill

1.1 Gross to Sell Bill

& Edit View Tools Valuation 1: Fri 25.Jun 2010
MNet Markup®
L ltem Bill description Bill gty Rate Amount % Type
= VENTILATION SHAFT & SUBSTATION CONTRACT 6.087.098.93
=2 SECTION 2: VENTILATION SHAFT 4.062.000.14
=3 SCHEDULE NO.1: FAN FOUNDATION 4.02325205
=4 EARTHWORKS 1.009.989.71
A Clear and strip site .400m2 3.96 21.366.78 10.000|Trade
B Excavate in bulk. Class A material and dispose | 10.800m3 39.80 429.859.47;  10.000|Trade
within 2km freehaul distance
C Excavation in foundations ne 2m deep 1.125m3 3442 3872753 10.000|Trade
D Excavate forworking space in Class A material  |660m3 27.02 1783568 10.000|Trade
and backfill and compactto 95% mod. AASHTO |
E Excavate in class A material for trenches and use |390m3 74.74 2914944 10.000|Trade
for backdill. compact. and dispose of surplus
material
F Extra over all excavations in Class A materialfor  [318m3 82.00 25530.00f, 10.000|Trade
Class B material
Bill page: 1 M4/ 186 b P

Res
Risk %

1312

1.184

1.116

1.166

1.167

= = EEE
RAQOXREL @
Gross Selling
Rate Amount Rate Amount Atfributes
6.848553.97 6.857.689.51 -
457158870 4.579.408.92 3
452784845 4.535.668.69
1.123.74332 1.129.092.30
441 23‘811.72| 439 23.706.00|WT% L
44.30 478.444.91 ‘ 44.80 43384000 WT% L
3829 43,076. D5| 35.02 39.39750WT% L
3007 19.848. DS‘ 3025 19.965.00(WT% L
83.13 3243853 8372 32650.80WT% L
90.20 2841 3.DD| 90.20 28413.00)WT L

[Goto page | [ Worksheet |§| [ Calcuiate ‘E‘

Notice that the Net and Gross rates havechanged as these items use the cheaper diesel in their
make-up. The Selling rates remained fixed and the calculated markup has increased in relation to

the Selling.

5.2 Explode Macros

Macro Price codes are ideal for the estimator to price but are not suitable for the site team to
progress against. For example progressing 50% of the Manhole willgenerate 50% allowable for
Excavdions, Concrete, Brickwork etc. The solution to this problem is to explode Macro Price codes
so that Excavations, Concrete, Brickwork may be progressed against.

Do this:
Access document3.1 Variation Pricing

This document is ideal for variation pri cing.

Valuation document Manager
Q Document Edit View Tools

Valuation Bills |Price codes I Resources I Indirects I Costs & Mlowables

Valuation Bill documents

@ 1. Valuation Bills
@ 2 Valuation input
I 3. Vadati ers
3.1 Variation Pricing
-2 Vanaton Urderswath BOQ allocations
3.3 Vanation Orders - Financial Summary
3 4 Variation Order Bill
4_¥aluation Comparisons and Trends
5. ¥aluation - Analysis

>
>
@ 6. Costs to complete
>
*

!

7. Subcontract Adjudication
8. Subcontract Manager
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Post Tender Valuations & Budget Control

Value Engineering

2.5a My Variation Prici ==
& Edit View Tools | Valuation 1: Fi 25 Jun 2010 HRAPOXAELS @
. Variation order Price Net Final Selling Final
L ltem Code Status Bill descriptio 7 Unit | Attib Final gty Code Rate Netamount = Markup% Rate Sellamt
= GROUTING 10721750 121.173.00
cC Cement and sand (1:3) grouting under bases & dm3 WT% L 17.925|C825213 598 107.217.90 13.016 6.76 121.173.00
L] HD bolt pockets.
=4 STORMWATER DRAINAGE 236,565.67 267.712.80
r o} Supply. bed and lay 375mm dia class 75D m WT%L 375|L8110r 22564 84.615.69 13512 256.13 96.048.75
concrete pipe
e Supply and install manholes consisting of =
one-brick walls, a concrete bottom slab 100mm
thick. concrete caver siab including a 600x600mm
L single seal C.L manhole cover and frame.
L] E Manhole size 1000x1200x1500mm deep internally. [no WT% L 15(L8371 5,066.42 75.996.27 12975 5.723.80 85.857.00,
_ F Manhole size 1200x1200x1500mm deep internally. |no WT% L 15/9L8372 506358 7595371 12873 572047 85.807.05
_=3 SCHEDULE NO2- FAN 33.748.09 43.74023
r G Purchase transport & deliver a "SPECIAL TYPE"  |item WT%L 1{mo01 217676 2177576 13.827F 3161644 31.616.44
mik Il fan from nominated supplierWEEMACFAN
L Ltd., 17 3rd Street HOUSTON, TEXAS, USA. Install =
Bil page: 3 [M4rzes b M| [Gotopage | [ Worksheet <) [ Caloulate [+

Right click on the price code column header and select Explode Macro Price codes > Explode

Macros without recoding

| & =EES

Valuation 1: Fri 25 Jun 2010

DX EHI @

Price Net Final Selling Final
Bill description Unit  Aftributes  Final gty Code Rate Netamount = Markup% Rate Sell amt
Sort 3 o
GROUTING Filter.. > 121.173.00
) Group by.. 4
Cement and sand (1:3) grouting under bases & dm3 WT%L 17925 # Find Chil«F 6.76 121173.00
HD bolt pockets.
XREF Price codes 4
STORMWATER DRAINAGE 26771280
ist worksheet
Supply. bed and lay 375mm dia class 75D m WTS L 375 Clrealmae s 256.13 96.048.75
concrete pipe Make unigue Price codes for uncoded items
Supply and install manfioles consisting of ﬁamde _d'j'p“cate EucEcosss 3
ane-brick walls. 2 concrete bottom slab 100mm Copy pricing from..
thick, concrete cover siab including 2 600x600mm Clear Price codes
single seal C.L manhole cover and friame. Make Resources/Worksheets from Price codes
Delete ALL unused Price codes
Manhole size 1000x1200x1500mm deep intemnally. |no WT% L 15 572380 85,857.00
Mark Price codes for master 4
Manhole size 1200x1200x1500mm deep intemally. |no WT%L 15 Explode Macro Price codes Explode Macros and recode
Explode Ma ithout il
SCHEDULE NO.2- FAN Column layout.. Ctrl+F1 | Siploce Macros WIthout recading

Click Yes

Imtemal Price codes will not be recoded

Explode Macro Price codes
Explode the selected Macro Price codes?

[ Yes Mo

J

Completed successfully
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Post Tender Valuations & Budget Control Value Engineering

Note: The additional Internal Items were added below Item F. Internal Items only have anet rate
and no Sellingr at e. I nternal items are marked with an ol
not be printed on the Interim Payment claim to the client. Item Fis the external item and
therefore only has a selling and no Net rate.

2.5a My Variation Pricing = B EEE
@ Edit View Tools | Valuation 1: Fi 25 Jun 2010 RUAQOXNHS @
. Variation order Price Net Final Selling Final

T L lem Code Status Bill d iption Unit  Attrib Final gty Code Rate Netamount = Markup% Rate Sellamt

: F Manhole size 1200x1200x1500mm deep intemally. [no WT 15| LO00S0 ex9L8372 572047 85,807.05 i
: 9 Exc manholes Wn3 WT% | E7311 107.47 |Rate only 0.00
: 9 Conc 20Mpa: Manholes wm3 WT% | C7821 790.03 |Rate only 0.00
: Conc 20Mpa: Benching Wm3 WT% | C7862 1,025.68 | Rate only 0.00
: 9 Fwk; manholes; soffits w2 WT% | F7825 238.84|Rate only 0.00_
: 9 Fwk: narrow widths; manholes il WT% | F7826 66.13 | Rate anly 0(]'[]ﬂ
: Reinforcing in manholes kg WT% | R7828 3.09|Rate only 0.00
: 9 1 stock brick wall: manholes w2 WT% | B7842 261.83|Rate only 0.00
: 9 Galv. Step irons WNo WT% | M7881 9.65 |Rate only 0.00
: Manhole cover Type 1 No WT% | M7883 436.52|Rate only 0.00
: 9 Plaster. manholes w2 WT% | P7364 85.78 |Rate only 0.00
apage: 3 | M 4[30f6 b M | [Gotopage | [ Workshest [<v [ Caloulate [<3)

Copy Bill to Final Qty
Note the Internal items do not have final qtyds,

Do this
Do a filter for internal Items.

Right click in the attributes column header, select filter > Internal items

Price Met Final
o = | Code Rate Metamount = M

Sort L I I I

| Filter.. Start a new filter
Group by.. L4 Filter for blanks

#3) Find Curl+F Headings and comments
Set 4 Items reflecting Price code descriptions
UnSet 4 Pricing
Column layout.. Ctrl+F1 Proyisional
Markups

Bill-Price code discrepancies

Items with Price codes marked for master

21,600 21,600 [ Internal items

16 Internal Items are filtered

FRiter Toolbar - 18

[Abandon] [Shuw rejects] [Hide headers] [I.n'u'ert] [Select ]
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Right click in the Final Qty Column header, Select filtered records

Copy from selected quantity

Select Bill Quantity

Yes to confirm

16 Quantities copied to final

48




































































































































































































































































































































